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Map Builder Guide

This is about Oracle Map Builder 10.1.3.3 installed on home PC, office PC, and a flash drive.
It is written in the first person, to be able to describe personal reactions and discoveries.

It is not easy to find that version, but you can register at OTN (Oracle Technical Network),
and try this address: http://www.oracle.com/technetwork/middleware/mapviewer/downloads/index.html
If that fails, google    ‘oracle map viewer’  or ‘oracle fusion middleware’.  Among the download choices,  under Version 11g PS6, click on Download Map Builder.  After the download of this .rar file, extract it, and it will contain an executable jar file,  mapbuilder.jar.  Double click it and you will have started.

The first thing you need to do is establish an Oracle database connection.  The GUI to do so 
is a lot like for map viewer.  Here is a screen shot, with the add connection GUI overlaid:
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Left center on the main screen is a metadata hierarchy tree, or toctree, in Map Objects terminology, but Navigation Panel in MapBuilderese.  At bottom left is a Show Data button.  When clicked, one sees the database tables in the connection you have selected, and created earlier.  This is under Spatial Tables, and the submenu Geometry Tables, and the submenu  Scott.  By clicking on the Models button, there is a submenu Network Models that contained my unet network.

The Tools menu contains the item Import Shapefile and this tool worked.    I navigated to a 
shapefile for Canada, and clicked my way to creating a spatial table for Provinces, the name of 
the shapefile and the name of the SDO table.  In the process, a theme was created for Provinces, which means some XML was generated.  This showed up in metadata under
Themes/Geometry Themes/PROVINCES, and was my first Metadata.  This theme showed up in
Oracle under USER_SDO_THEMES, but the entire STYLING_RULES did not display from select *.  STYLING_RULES is of type CLOB which might account for that.

One can see the style rule by clicking on the XML tab under the main window in the map builder GUI.  It is as follows:
                     <?xml version=”1.0” standalone=”yes”?>
                     <styling_rules>
                         <rule>
                             <features style=”C.RED”> </features>
                         </rule>
                     </styling_rules>          

Scott had not defined C.RED, which was the default, and this drew a warning message.
The Preview tab showed a map of Canada.  After making a couple of themes, it should be possible to make a base map with those themes, and then try to display that.  At a simple level this process bundles a theme with both an SDO table, and a style.     

The way to create something is to right click on a metadata entry in the metadata toc.  Right
clicked on Styles/Colors and created c.red and c.black, and they work but you have to restart
map builder after a creation.   Also created Styles/Markers/M.blackpoint.
Left C.red the style of PROVINCES.  Then created canadaCities, and made its style M.blackpoint.
Now have two reasonable themes for Canada. When the style for canadaCities was C.black, they displayed as default little black x’s.  When making a marker you can control size and shape
(can choose Circle, and I did).

Next up was creating a Canada base map with themes provinces, and canadacities.  The preview did what it should have.  Moreover, it was visible also from map viewer using
the mapclient button in demos, with data source as sdsu and base map as Canada.
  In map builder preview, getting the map to occupy most of the screen is a trick not yet learned.  Another issue is that the identify tool needs to be hit more than once to identify a city. 
Made the cities green, to show up better over coastal boundary in black.     Finally created
Styles/Texts/T.canadacities12, with a halo, and set that to label the name field in canadaCities theme.  The rendering is pretty nice.  Here is a picture:

      [image: ]

Figure 1.

At the bottom of what is shown are the three tabs Editor, XML, and Preview.  Editing varies with
what you are trying to edit.   Editing a theme is common, e.g. you might want to labeling somewhere down the road.  To edit a theme, you click on it to display it.  You can then click on
Styling Rules, and then click on the pencil about the styling rules, and edit the styling rules.
You can then change a rule to use a different marker or color or text or ……..
This was how I replaced c.black by m.greencircle

A picture of that now follows
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Figure 2.


Note the many pencils in the Figure above, after Styling Rules has been clicked.  Note that Save and Save All, under the File menu, are greyed out UNTIL you make a change in a style, theme, 
or map.  
 
Another observation is that ESRI products display things as part of the application windows,
but these Oracle products display in browsers.  One can thus save or print using browser facilities. 

 By contrast there is no easy way to save a Map Builder preview.





We next examine a simple Color  style, c.black    Here is the generated XML code:
     <?xml version=”1.0” standalone=”yes”?>
     <svg width=”1in” height=”1in”>
         <desc/>
         <g class=”color” style=”stroke:#000000;stroke-width:3.0;fill:#000000”>
              <rect width=”50” height=”50”/>
         </g>
     </svg>    
This describes an all black rectangular color.  Now svg refers to Scalable Vector Graphics which is a W3C standard for graphics descriptions in XML format.  Browsers usually recognize SVG.  Each style has a single g element like this one does.  The point is that the XML here is standard when it comes to format.   A kind of minimum of color styles is C.Red, C.Black, C.Blue, and C.Base, where C.base is some kind of mellow color for showing a base map.

A Marker style is for rendering point layers.  Here is a screen shot of the ‘editor’ page that shows the specs for defining a black circle marker:
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The XML code is similar to that above, but has g class = “marker”, among other changes.

You create a Text style to indicate how you want labels to be rendered and can attach that to any layer.  An appropriate name might be Courier12, or something to suggest what your choices were, but my title ties the text style to a layer using T.uscoterm.  Here then is a picture of the editor screen to indicate how to label the ‘coterminous’ US, meaning Alaska and Hawaii are given short shrift:

[image: ]

For a polyline layer like rivers, you must create a Line style.

Next we want to describe how to create a theme, i.e. a map layer.  Click on Themes in the Map Builder table of contents and you get a sublist that includes Geometry Themes.  Right click on that and you get a sequence of 4  interfaces that allows you to define a theme from an Oracle SDO table.  The first ‘real’ GUI is where you pick a theme name, like cotermUS, an also select
your SDO table.  In the next screen you pick a rendering style like C.Base to determine the color.
And in the screen after that you can choose to select a Text style for labeling.  In that dialog you need to select the column to use for labels, an in the states theme, the state_name column is not first, so specifying a column is important.

Of course the ultimate goal is a map which contains some of the themes you have create, like the map of Canada displayed earlier.  You right click on Base Maps in the toc, as per usual.
You choose a map name , and then to that the themes you made earlier and wish to include.
In the first real screen you can pick the map name CotermUnitedStates, and enter a description such as US states minus Alaska and Hawaii.  In the next screen you get to select themes from your list of themes created by Map Builder.  I added the themes for the base map,USlakes, and USrivers  to the map.  The order in which themes are added affects the order in which the layers are displayed, so opaque layers should be added before polyline and point layers.

I made a bit of a mistake in long range planning.  I should have created a spatial table for 
coterminuous  rivers, and imported that to Map Builder, so that the layers would have similar ‘extents’.  That can not easily be done in Map Builder, and should be done in some other way.
It was.  Here is the US map seen by Map Builder preview.
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Zooming in would reveal more labels.

Here is the screen where you choose themes when making a new base map:
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That completes the tour of basic features in Map Builder.


Next up is the idea that when you use map builder, the styles and themes and maps you create make their way into these tables:  user_sdo_styles, user_sdo_themes, and user_sdo_maps.
The user_sdo_maps table has 3 fields:
       name   VARCHAR2(32)
       description  VARCHAR(4000)
       definition    CLOB
If you just do a select definition from user_sdo_maps, the definition, which is the XML you built, will not fully display, since a clob is default truncated to something like its first 80 characters.  
In SQL*Plus, an easy cure is:   set long 2000.  This affects the number of bytes shown from a 
CLOB.

The following  spool file shows another cure and the output:

SQL> select dbms_lob.substr(definition,4000,1) from user_sdo_maps;

DBMS_LOB.SUBSTR(DEFINITION,4000,1)                                              
--------------------------------------------------------------------------------
<?xml version="1.0" standalone="yes"?>                                          
  <map_definition>                                                              
    <theme name="PROVINCES"/>                                                   
    <theme name="CANADACITIES"/>                                                
  </map_definition>                                                             
                                                                                
<?xml version="1.0" standalone="yes"?>                                          
  <map_definition>                                                              
    <theme name="COTERMUS"/>                                                    
    <theme name="USLAKES"/>                                                     
    <theme name="COTERMRIVERS"/>                                                
  </map_definition>                                                             
                                                                                

SQL> spool off

These tables are used by Map Viewer when you ask Map  Viewer for service.

Map Builder can be thought of as an IDE for Map Viewer.  It allows easy creation, by clicks and textfields, of XML that Map Viewer can use to make map renderings in a browser.  Most GIS firms create shapefile viewers in standalone windows.  And they do not make displays directly from SDO tables, nor are good conversions from SDO tables to shapefiles easy to find.

To pause on a light note, an Area style was created that is a bit fishy.  The result was a map of the coterminous United States if certain global warming predictions had been exceeded.
[image: ]


Having explored the creation of about 5 kinds of styles, several themes, and two base maps, the next thing is to explore the relationship between Map Builder, Oracle SDO and MapViewer.  The assumption is that the reader knows about SDO tables, and has come to terms with Map Viewer, to the extent of creating a valid Data Source.  None of these victories is free or even easy, but neither is learning to build a boat, etc etc etc.

There are, as mentioned, 3 Oracle tables created when using Map Builder, with the names 
user_sdo_styles, user_sdo_themes, and user_sdo_maps.  

In the foregoing discussion, two base maps were created:   CANADA and COTERMUS.  After creation, map builder automatically created rows in user_sdo_maps.  

The following spool file (Oracle transcript file) was created using SQLPLUS.  I entered, as scott/tiger, the line    
SQL>  SPOOL usersdomaps
then typed the commands seen below, and then said  
SQL>  SPOOL off.  

Here is the dialog created in my file space as the file 
usersdomaps.LST:




SQL> set long 500
SQL> set pages 500
SQL> select * from user_sdo_maps;

NAME                                                                            
--------------------------------                                                
DESCRIPTION                                                                     
--------------------------------------------------------------------------------
DEFINITION                                                                      
--------------------------------------------------------------------------------
CANADA                                                                          
                                                                                
<?xml version="1.0" standalone="yes"?>                                          
  <map_definition>                                                              
    <theme name="PROVINCES"/>                                                   
    <theme name="CANADACITIES"/>                                                
  </map_definition>                                                             
                                                                                
COTERMUS                                                                        
                                                                                
<?xml version="1.0" standalone="yes"?>                                          
  <map_definition>                                                              
    <theme name="COTERMUS"/>                                                    
    <theme name="USLAKES"/>                                                     
    <theme name="COTERMRIVERS"/>                                                
  </map_definition>                                                             
                                                                                

SQL> spool off

I did not create descriptions when I made the base maps, so that field shows as ‘null’.  The definition fields are the XML codes.  If you enter desc user_sdo_maps, you will see these attributes and attributes types:
NAME                         NOT NULL         VARCHAR2(32)
DESCRIPTION                                        VARCHAR2(4000)
DEFINITION               NOT NULL          CLOB
As noted somewhere, by default Oracle does not display more than the first 80 letters in a CLOB,  and  SET LONG 500 is the easiest cure.  

In any case that is one interplay between Oracle Map Builder and Oracle tables.  The other is that when Map Builder tries to build a theme, it needs an SDO table as input. In theory you could enter rows in user_sdo_maps using only SQL.  Map Viewer visits this table and the other two as needed.

Now we look at the interplay with Map Viewer.  The Map Viewer handout is strictly about the first entry under DEMOS, which is JVIEW, which can display SDO tables in either local or geodetic coordinates.  The second entry is MAPCLIENT.JSP.  When you click on that you get a GUI like that below, which of course wants a Data Source.  It also has a field for a base map, with no handy drop down list.  I entered sdsu as data source, which is for scott/tiger, where the base map cotermus lives.  You want a kind of median longitude and latitude for the US in the Map Center X and Map  Center Y fields, if you hope to see a map.   Map Size can be initially entered as 70, or something similar.  Once the image shows up, you can use the pan and zoom buttons to make it look the way you want.   This is not the easiest interface to use, but not too bad.
Here is the screen shot:

[image: ]

As you zoom and pan, the Map Center and Map Size fields will be automatically adjusted for you.

As it turns out, the Advanced styles are not quite as simple to waltz your way through.  So we will do one of the simplest ones possible.  When you right click on Advanced and volunteer to create a style, you get a little group of 8 picture icons, and the upper right one says Color Scheme.  A click on that gives you a GUI.  The style name I choose was V.Red  You are trying to select a set of colors, so that your features, e.g.  states, are placed into a small number of buckets, where the states in a given bucket are rendered in a particular shade of red.

You can choose a border color, a fill color, and bucket parameters.  If you choose a light shade of red, the colors will be darker and darker shades of red, ranging up to black.  Many GIS tools doing this would start at white and finish with your color choice, but not Map Builder.  You then associate your variable color scheme with a numeric column.  I chose US states (coterminous) and the attribute Pop1999, i.e. state population in 1999.  It is in V.red that I had to choose the number of buckets I wanted, which is annoying, as well as the high and values of my column, which is even more annoying, and means my advanced style is not at all versatile.  Here is the screen shot:

[image: ]

Under bucket type I picked Equal Range.  To get Bucket Information to show up, you have to click on the WORDS Equal Range, a surprise.  Since I will later pick Pop1999, I had to go look
at high pop and low pop and then enter the values 480000 (a shade low) and 34,000,000 ( a shade high).  As said earlier, the Base Color was a light red, roughly hex FF6060.  Then saved V.Red.

Next up was building a new Geometry Theme, named USPop.   Under Styling Rules I chose V.Red.  After doing that you get some choices that look like this:

      Attributes (for Advanced Styles)
                        Style                          Attribute
   V.Red                                  Age_18_29
where Age_18_29 is the first column of attributes for the states layer.  When you click on that you get a shot at a drop down list of all the columns, and I selected Pop1999.  Here is that mini
screen shot:
[image: ]

Having thus made a USPop theme, here is the preview, which came out acceptably, and those are shades of red, if you are lucky enough to see this in color.  Here we go:

[image: ]

Choropleth maps are very useful for visualizing statistical data, and patterns therein.  This leaves 7 other Advanced Styles for you to explore.
The next topic is using Map Builder to create georaster tables.   Map Builder is the easiest way to do this.  A georaster table can contain images, or geographic photos, such as those taken from a plane or from a satellite.  Such photos are often called landsat images, i.e. an image of the Earth’s surface taken from a satellite.   The format used for the image is often .tif, or equivalently .tiff, standing for tagged image file format.   These are high resolution space consuming photos, which should hold up well under multiple zoomins.  These images should be ‘georeferenced’, which is to say we need to say where the image belongs on the surface of the Earth.  Since this technology can be used for local coordinates, georeferencing is not always important to us.

Oracle spatial uses two tables, one with a column of type SDO_GEORASTER.  This might be called georaster_table6, with a georid field of type NUMBER, and maybe a name field of type VARCHAR2.  So  three fields would be normal, but there can be just two fields, or even just one field.    The second companion table is called a ‘raster data table’, and might be called rdt6.
The actual images are in a RASTERBLOCK field in the RDT table.  The other required fields are RASTERID, PYRAMIDLEVEL, BANDBLOCKNUMBER, ROWBLOCKNUMBER, COLUMNBLOCKNUMBER, and BLOCKMBR.  The first 5 are numeric, and the last has type
MDSYS.SDO_GEOMETRY.  RASTRBLOCK has type BLOB.

It is not easy to set these tables up.  It can be done with Java, or via PL/SQL,  or using functions from SDO_GEOR, but the easiest way is to use Map Builder.  To use Map Builder, click on the Tools menu, and then click on Import Image. The following dialog window will appear:

[image: ]
If you click on New Table, then Map Builder will create a georaster table and a raster data table for you.  Or you can select existing tables.  Then click on Image File, and navigate to an image, e.g. ColoradoCrust.tif.  The next screen is for selecting an SRID, e.g. 8307 or 262148 (another magic number), and a georeference, either by Coordinate, or an ESRI World File.  Here is that screen, with examples fillins:

[image: ]

After Next and Finish, you still have steps to go.  You will be asked if you want to create a georaster theme from this image.   Say yes.  Pick a name for the theme, e.g. Toltec, and maybe a description, and choose your tables.  Then Map Builder does more behind the scenes work, and you have a georaster theme.   You can preview it.   For example, here is a Toltec Warrior image made using the steps presented above:

[image: ]

Now we try to see what mapviewer has done.  The following spool file shows what Map Builder has entered in the georaster table.

QL> set pages 1000
SQL> set long 1000
SQL> /
                                                                               
SDO_GEORASTER(20001, SDO_GEOMETRY(2003, 262148, NULL, SDO_ELEM_INFO_ARRAY(1, 100
3, 1), SDO_ORDINATE_ARRAY(100, 100, 100, -37400, 100, -74900, 13100, -74650, 
26600, -74650, 26350, -37400, 26600, 350, 13100, 100, 100, 100)), 'RDT_GEOR3', 
32, XMLTYPE(<georasterMetadata xmlns="http://xmlns.oracle.com/spatial/georaster"
>                                                                               
  <objectInfo>                                                                  
    <rasterType>20001</rasterType>                                              
    <isBlank>false</isBlank>                                                    
    <defaultRed>1</defaultRed>                                                  
    <defaultGreen>1</defaultGreen>                                              
    <defaultBlue>1</defaultBlue>                                                
  </objectInfo>                                                                 
  <rasterInfo>                                                                  
    <cellRepresentation>UNDEFINED</cellRepresentation>                          
    <cellDepth>8BIT_U</cellDepth>                                               
    <totalDimensions>2</totalDimensions>                                        
    <dimensionSize type="ROW">                                                  
      <size>150</size>                                                          
    </dimensionSize>                                                            
    <dimensionSize type="COLUMN">                                               
      <size>53</size>                                                           
    </dimensionSize>                                                            
    <ULTCoordinate>                                                             
      <row>0</row>                                                              
      <column>0</column>                                                        
    </ULTCoordinate>                                                            
    <blocking>                                                                  
      <type>REGULAR</type>                                                      
      <totalRowBlocks>1</totalRowBlocks>                                        
      <totalColumnBlocks>1</totalColumnBlocks>                                  
      <rowBlockSize>256</rowBlockSize>                                          
      <columnBlockSize>256</columnBlockSize>                                    
    </blocking>                                                                 
    <interleaving>BIP</interleaving>                                            
    <pyramid>                                                                   
      <type>DECREASE</type>                                                     
      <resampling>NN</resampling>                                               
      <maxL))                                                                   
                                                                                

SQL> spool off

Note the large XML file that was included, free of charge.  The following entry was automatically made in USER_SDO_THEMES:
TOLTEC
warrior
GEORASTER_TABLE3
GEORASTER
<?xml version=”1.0” standalone=”yes”?>
<styling_rules theme_type=”georaster” raster_id=”32” raster_table=”rdt_geor3”>
</styling_rules>   

This is the ‘link’ between a georaster row and a raster data table row.

You should be able to find a GEORASTER entry in Map Viewer somewhere under Demos

The next screen shot shows a success, and was achieved by zooming out a lot and then adjusting.[image: ]

It is pretty tricky to do all this without the aid of Map Builder.  And pretty easy with it.

ONE CAVEAT: Oracle11g XE does everything else above and does map viewer, but it does not
[bookmark: _GoBack]do georaster.  In particular, it does not do the type sdo_georaster.  To do map viewer, I needed mv11ps3_quickstart version of map viewer.   
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